Please note that Cypress is an Infineon Technologies Company.
The document following this cover page is marked as “Cypress” document as this is the company that originally developed the product. Please note that Infineon will continue to offer the product to new and existing customers as part of the Infineon product portfolio.

**Continuity of document content**
The fact that Infineon offers the following product as part of the Infineon product portfolio does not lead to any changes to this document. Future revisions will occur when appropriate, and any changes will be set out on the document history page.

**Continuity of ordering part numbers**
Infineon continues to support existing part numbers. Please continue to use the ordering part numbers listed in the datasheet for ordering.
THIS SPEC IS OBSOLETE

Spec No: 001-58765

Spec Title: CCT AND CRI IN LED LIGHTING - AN58765

Sunset Owner: MADHAN KUMAR KUPPASWAMY (MKKU)

Replaced by: NONE
AN58765

Authors: Prasanna Vijayakumar and Kaushal Vora
Associated Project: No
Associated Part Family: CY8CLEDxx
CY8CLED0xD/G0x
Software Version: PSoC Designer™ 5.0
Associated Application Notes: None

Application Note Abstract
Solid state lighting is important in the general illumination market because of the recent improvements in phosphor-based white LED technology. Cypress Semiconductor's EZColor™ and PowerPSoc® family of devices can be used to build light engines using LEDs for a variety of applications including general illumination. This application note explains the color quality parameters for white light sources and describes a tool developed by Cypress to estimate Color Rendering Index (CRI) of a LED luminaire. This application note also describes how Cypress's lighting solutions can control LEDs and meet luminaire specifications set by compliance agencies like Energy Star. To learn more about Cypress's lighting solutions visit www.cypress.com/lighting.

Introduction
Most of the lights used for general illumination are white. Light and color are inextricably connected; in the sense that light is also a color. When looking at a uniform light source, the color we see is described by brightness (in lumens) and two chromaticity coordinates. Visible light is that portion of the electromagnetic spectrum which appears violet at shorter wavelengths and red at longer wavelengths. All other colors - blue, blue-green, green, yellow, and orange - appear in the middle as shown in Figure 1.

Figure 1. Electromagnetic Spectrum

A spectrum that contains roughly equal amounts of all the visible wavelengths appears white. However, for a given light source, even with variations in wavelengths and their spectral powers, the light may still appear white. Although spectral variations in a light source can be captured by a spectroradiometer, they are evident to the human eye only when the light source is used to illuminate an object or render colors. For example, an apple appears red when illuminated by a white light because the apple reflects light in the red portion of the spectrum and absorbs light at other wavelengths. If the same experiment is repeated by filtering out the red portion of the white light source, the apple appears black. This is because the light we see is modified by the object. Therefore, even though we can describe the light source's color using brightness and chromaticity coordinates, it is complex to analyze the color of an object illuminated by the same light source because it depends on the object and the spectral properties of the light source.

Because the light source can change the way an object or an area is perceived, it can change the appeal and ease of recognition of the object or area. The ability of a light source to render objects well is an important characteristic of the light source. To understand this, let us discuss key metrics used today to specify white light.

Correlated Color Temperature
One way of specifying approximate chromaticity of white light is by referring to its Correlated Color Temperature (CCT). CCT is based on the concept of Color Temperature (CT). The CT of a light source is the temperature in Kelvin (K) at which the color of a heated black body radiator (or Planckian radiator) matches the color of the light source. On heating, the black body glows deep red initially at low temperatures and eventually blue-white at very high temperatures. The temperature is specified in Kelvin (K).
Planck's law gives the intensity of the energy radiated by a black body as a function of wavelength and temperature. Therefore, every CT has a unique color associated, defined by its chromaticity coordinates (x, y). A black body locus is obtained when these chromaticity coordinates are plotted on the standard color space (CIE 1931) as shown in Figure 3. White lighting for general illumination usually falls in the range of 2,000 to 10,000K.

The color temperature characteristics of an incandescent bulb can be approximated to a black body because the tungsten filament inside the bulb radiates light due to high temperature. However, fluorescent and LED-based white light sources use other techniques to generate and modify light color and, therefore, require a different method to define color temperature. Therefore, a new metric, CCT, was introduced. CCT is defined as the temperature of a black body radiator whose chromaticity is closest to that of the light source on a perceptually uniform color space (CIE 1960 UCS or CIE 1976).

The CCT rating for a lamp, luminaire, or fixture is a general indication of its color appearance (warm or cool). Light sources with a CCT rating below 3200K are usually classified as "warm", while those with a CCT rating above 4000K are usually classified as "cool" in appearance. Although CCT is a good indication of the lamp's general appearance, it does not provide information about the lamp's spectral power distribution. For example, as shown in Figure 4, two lamps A and B can have the same CCT (6000K) but different color appearance. Lamp A appears greenish white while Lamp B appears pinkish [1].

When lamps A and B are used to illuminate an object, the color rendered by them can vary significantly. This is because a particular CCT refers to a line of chromaticity coordinates on the color space instead of a single color. Moreover, when following the CIE guidelines for estimating CCT, the CCT calculated by different researchers can vary in the order of several tenths of a Kelvin to a few Kelvins for the same spectrum. Therefore, CCT alone is not a very good indicator of a lamp's color rendering property. The International Commission on Illumination (CIE) has developed another metric called the Color Rendering Index (CRI) to ratify the color quality of a white light source. CRI is based on the concept of comparing the light source to a known reference. Although the relevance of this metric for LED based light sources is debatable, it is the only standardized metric recognized by CIE for estimating color quality or the color rendering property of white light sources.

**Color Rendering Index**

The Color Rendering Index (CRI) defines how accurately a sample light source reproduces an illuminated object's color in comparison to a reference light source of comparable color temperature. CRI is a unitless quantity. Higher CRI values correspond to better color rendering with a maximum value of 100. Depending on the application, the CRI goal is most often in the range of 75 to 95. An example comparison of low versus high CRI illumination is illustrated in Figure 5. The source on the left seems to render red tomatoes better while the one on the right renders green grapes better.

**Figure 2. Blackbody Color Temperature**

Tunable WHITE using LEDs

![Blackbody Color Temperature](image)

**Figure 3. Blackbody Locus on CIE 1931**

![Blackbody Locus on CIE 1931](image)

**Figure 4. Zoomed-in View of Blackbody Locus**

![Zoomed-in View of Blackbody Locus](image)

**Figure 5. Color Rendering Quality for High versus Low CRI Lamp**

![Color Rendering Quality for High versus Low CRI Lamp](image)
However, it is important to note that both lamps shown in Figure 5 on page 2 have the same CCT. Both the lamps render colors differently because they do not have the same spectral power distributions (SPD). The SPD curves shown in Figure 6 provide precise color information for the light sources by charting the level of energy at each wavelength across the visible spectrum.

Figure 6. SPD Comparison

The SPD on the left is for an incandescent lamp and clearly shows the increased contribution of red in contrast to the SPD on right which is for a warm white (WW) fluorescent. The fluorescent lamp has very little deep red in its spectrum, which explains why the tomatoes appear a brighter red when illuminated with an incandescent light source instead.

The procedure for calculating CRI is as follows:

1. Calculate the color differences $\Delta E_i$ (on the 1964 UCS which is based on 1960 UCS) for the 14 CIE recommended Munsell sample colors (including pastels and saturated colors) between when illuminated by a reference illuminant versus the test illuminant. The reference is usually either the black body radiator for test sources with CCT under 5000 K or a phase of daylight otherwise.

2. The next step is to apply the von Kries chromatic adaptation transformation. Using this transformation the Special Color Rendering Index $R_i$ for each color sample can be calculated using Equation 1.

$$R_i = 100 - 4.6\Delta E_i$$  \hspace{1cm} Equation 1

3. The average of the first eight samples ($R_1$ to $R_8$) is defined as the General CRI or $R_a$. In addition to $R_1$ to $R_{14}$ and $R_a$, some lighting designers also include $R_{15}$ in their specifications. $R_{15}$ is a special CRI for a sample color that resembles the Japanese skin complexion under daylight. Lower average CRI values correspond to lower quality color rendering. For a CRI value of less than 35, the color rendering is poor and the specific CRI value is less meaningful. The calculated CRI values can be negative and such low CRI values occur when the light source does not have spectral intensity at the wavelengths emphasized by a particular test color patch.

Efficacy and Efficiency

In the previous sections CCT and CRI were introduced as two important metrics associated with qualifying white light sources. Another metric which is equally important while choosing a light source is the efficacy or lumens for each optical watt and wall plug efficiency or lumens for each electrical watt. Before getting into details let us look at the human eye’s sensitivity range (also known as the photopic response curve).

Figure 7. Photopic Response Curve ($V(\lambda)$)

Efficacy: As seen in Figure 7, the eye does not respond uniformly throughout the visible range. Given the same output power at each wavelength or color, the eye senses the yellow-green (around 555 nm) region as the brightest and the red-blue region as the darkest. This is why a light source which has most of its power in the yellow and yellow-green areas has the highest visual efficiency - the highest lumens for each watt. Looking at the spectrum of an incandescent light, the concentration of spectral power lies close to the IR region, which means a lot of energy is radiated away as heat, making the light source less efficient as compared to fluorescent or LED light sources. However as incandescent sources “render” colors of our environment in a natural form they have the best color rendering index rating (CRI=100). Therefore, the better the color rendition, the lower is the efficacy for most light sources.

Efficiency: The wall plug efficiency of a lighting system accounts for the losses in converting wall plug power to optical Watts in addition to the efficacy for each light source. Cypress’s PowerPSoC devices can be used to build light engines with efficiency greater than 90 percent. With recent advancements in LED technology, optically efficient light sources that can render colors well can be constructed. The next section discusses the challenges involved in building a LED light source with a high CRI. Cypress’s Color Quality Calculator, described later, addresses some of these challenges leading to significant reduction in design time.
White Light using LEDs

There are two ways to produce white light using LEDs:

- Monochromatic mixing – High brightness LEDs are available in different colors such as red, green, blue, and amber across the visible spectrum. Color mixing using the primary colors (RGB) enables a range of white light sources with CCTs throughout the black body locus (refer to Figure 3 on page 2). Some designers may include an amber or a white LED along with RGB to gain additional freedom to tune CRI, while others may just add a red or amber LED to a white LED-based system which is another form of color mixing. The techniques discussed in the application note AN16035 can be used along with Cypress’s EZ-Color and PowerPSoC family of devices to meet such needs.

- Using white LEDs – White LEDs are available in broad bin selection ranges with CCTs from 2500 to 10000K (warm, neutral, or cool in appearance). White LEDs are typically manufactured by placing a blue LED in a package internally coated with a light converting phosphor. Use of phosphors in the conversion process results in some energy loss, thereby making this technique less efficient compared to the color mixing technique. Additionally, a high CRI white LED results in lower lumens output due to an increased absorption of power from blue light.

Table 1 summarizes the pros and cons of both techniques for producing white light using LEDs. Key trade-offs like color quality, light output, luminous efficacy, and cost are compared. However, because some characteristics of LEDs like aging are not considered, picking one technique over the other is purely a design decision.

### Table 1. Comparison of RGB vs. White LED Method

<table>
<thead>
<tr>
<th>Parameter/Light Source</th>
<th>RGB</th>
<th>White LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Luminous Efficiency</td>
<td>High</td>
<td>Medium</td>
</tr>
<tr>
<td>Tunable</td>
<td>Yes</td>
<td>Usually restricted by manufacturer bins</td>
</tr>
<tr>
<td>Subjective Color</td>
<td>High</td>
<td>Low</td>
</tr>
<tr>
<td>Preference Rating [6]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Skin tone rendition [6]</td>
<td>High</td>
<td>Medium</td>
</tr>
<tr>
<td>Light degradation</td>
<td>Comparable</td>
<td>Comparable</td>
</tr>
<tr>
<td>Control Electronics</td>
<td>Complex</td>
<td>Simple</td>
</tr>
<tr>
<td>Secondary Optics Design</td>
<td>Complex</td>
<td>Simple</td>
</tr>
<tr>
<td>CRI</td>
<td>High</td>
<td>Medium</td>
</tr>
<tr>
<td>Cost</td>
<td>High</td>
<td>Medium</td>
</tr>
</tbody>
</table>

Challenges in Tunable White LED Luminaires

Usually a large number of tiny high brightness LEDs are required in a LED luminaire to achieve desired lumens, even for a simple application like a spot light. It is common practice to connect LEDs in series (as shown in Figure 8) because this enables combined dimming by controlling the current through the LED string. In most cases more than one LED string may be connected in parallel too. Therefore, a group of LED devices which are connected in series/parallel and for which electrical parameters (current/dimming) are controlled in a combined fashion is termed as a LED string.

A typical electrical system to control a LED string is shown in Figure 9. The LEDs are operated with a DC voltage. Therefore, a rectified line voltage is fed to a LED driver. The LED driver plays a key role and is required in every LED-based luminaire (non-white or white) to perform current control, dimming, and/or to add intelligence.

Cypress’s EZ Color/PowerPSoC family of intelligent LED drivers can be used to dim LED strings for applications such as high CRI tunable white light. The Cypress EZColor Color family of devices support up to 16 LED strings, whereas the PowerPSoC family, featuring integrated high power MOSFETS, supports up to four LED strings.

### Binning

Although LEDs may have the same output color they may exhibit variation in spectral properties. LEDs with similar color and lumen properties are grouped together in a “bin”. Binning is a result of variations in the manufacturing processes that exist for LEDs today. Therefore, a LED string may consist of LEDs from different bins. Figure 10 on page 5 illustrates a string with LEDs from multiple bins.
To analyze effects of binning on color quality for luminaries with LEDs from multiple bins, designers can simplify their analysis by dividing LED strings into sub-strings or groups. As shown in Figure 10, Bin#1 can be treated as one group with four LEDs, Bin#2 with one LED, and so on. Therefore, a group is the smallest entity in a luminaire which defines a set of LEDs that share common spectral properties. This definition of a group will be used later to describe the Color Quality Calculator tool. The concept of groups is important while choosing and grouping LEDs for a high CRI design. A high CRI design can have multiple monochromatic strings containing warm, neutral, or cool white LEDs, or even colored LEDs, each from the same or different bin (see Figure 11).

The application note AN16035 discusses binning for colored LEDs and Cypress’s Binning Compensation solution for color mixing. Binning applies to white LEDs too and not just non-white LEDs. Figure 12 shows a few white LED bins from a LED manufacturer.

The application note AN16035 discusses binning for colored LEDs and Cypress’s Binning Compensation solution for color mixing. Binning applies to white LEDs too and not just non-white LEDs. Figure 12 shows a few white LED bins from a LED manufacturer.

A system designer can tackle the binning problem in the following ways:

- Paying a premium to ensure LEDs are from same lot with the same bin code (LEDs may still require calibration at design time)
- Implementing a runtime optical feedback system to compensate for variations
- Modeling/Calibrating the luminaire during design and pre-embedding compensation using firmware to maintain color consistency throughout the lifetime of the fixture or luminaire

Although the first two options are straightforward, they are expensive and not recommended for cost sensitive applications. The last option is the most cost effective. It has its share of complexity but not many tools are available to model a LED luminaire. Cypress’s Color Quality Calculator allows the system designer to accurately model binning effects. Details about the tool are discussed in a later section.

**Thermal Degradation**

Another known problem with high brightness/high power LEDs is the degradation in light output with increase in temperature. The life expectancy of a LED system depends on its light output which, in turn, is highly dependent on temperature. Not all LEDs degrade in the same manner. The amount of degradation depends on the chemical composition of the LED. In general, InGaN-based LEDs like blue, green, or white have better thermal performance as compared to AlInGaP-based LEDs like red and amber (as shown in Figure 13).

As shown in Figure 13, the variation in degradation curves causes color shifts at elevated temperatures and affects a luminaire’s color quality parameters like CCT and CRI. A practical and cost effective approach to solve thermal problems in LED luminaires is to use a combination of an aluminum heat sink with a temperature feedback system. In some cases the design may use active cooling methods like a fan. Cypress Semiconductor has developed an easy-to-use temperature compensation method for high brightness LED solutions. For more information about the solution refer to the application note AN14406.
Parameters quoted on LED data sheets are usually used as a starting point to design a LED-based system that can compensate for binning and temperature effects. Advance lighting system designers use a spectroradiometer to calibrate LEDs instead of relying on data sheets. Both these methods require additional mathematical analysis to extrapolate system behavior at higher temperatures or binning variations. Some spectroradiometers include a PC-based software suite that can perform this mathematical analysis for the measured spectrum. However, these are expensive and increase lead time. Hence cost and time sensitive designs may compromise on color quality due to lack of time, expertise, or availability of expensive spectral measurement equipment and software tools.

Cypress’s Color Quality Calculator (CQC) is designed to lessen these problems to some extent by enabling system designers to model their LED luminaires precisely, to a point of defining individual LED properties. It provides a quick solution for modeling binning and temperature variations. The tool is useful for designers in architectural and general indoor lighting space where color quality requirements are prominent. Apart from having the ability to estimate CCT and CRI for a luminaire, the tool can generate normalized SPDs and also compute dimming values for multiple LED strings. These dimming values can further be used as signal density/duty cycle inputs for PrISM/PWM modulators built into Cypress’s EZ-Color and PowerPSoC family of devices.

Cypress’s Color Quality Calculator (CQC)

Figure 14 shows a snapshot of the CQC tool. As illustrated, the fields can be divided into two categories: inputs and outputs.

- Inputs – Information required to model a LED luminaire is entered here.
- Outputs – The metrics used to estimate color quality are displayed here. The SPD and CIE diagrams are part of the outputs and convey output parameters graphically.

A detailed explanation of each section follows.

CQC- Target Color Inputs Section

This section is a precursor to specifying actual inputs. It is used to define the way in which inputs are specified by the user and enables selection of outputs that must be calculated by the tool.

Figure 15. Target Color Inputs

**Lumens**: This input requires specification of the total lumens output of the lamp under test.

**Chromaticity Coordinates**: These inputs enable you to select one of the three color spaces, u’v’, uv, or xy corresponding to CIE1976, CIE1960, or CIE1931 respectively. Based on the color space selection, the target color’s coordinates can be specified. Alternatively, you can choose to enter the measured or known CCT of the test lamp.
Enable CRI estimate: This checkbox enables/disables CRI estimation. In some cases the tool may just be used to compute dimming values for each LED string. Therefore, the tool serves as a color mix analyzer, where multiple LED strings are mixed to obtain a desired color point.

Enable Output Limits: This checkbox allows you to enable/disable rounding-off for calculated dimming values to the resolution value entered in the resolution input field. Figure 16 shows dimming outputs when rounded-off with a resolution of 0.2.

Figure 16. Outputs with a Resolution of 0.2

![Figure 16](image)

Figure 17 shows dimming outputs when the Enable Output Limits option is disabled.

Figure 17. Outputs with Enable Output Limits Disabled

![Figure 17](image)

This particular feature is useful when values from the tool are directly used with analog or digital dimming hardware blocks with different resolution specifications.

CQC- LED String Inputs Section

This section enables the user to define properties of a LED string. Version 1.0 of the tool supports up to a maximum of eight strings and string properties can be defined as absolute or relative values.

LED Strings: This label enables you to associate every defined string with a number.

String Enable: This checkbox allows you to enable/disable one or more LED strings from the calculation. You may want to disable one or more strings to study the impact on CRI as if the strings were physically removed from the design. For example, you may want to add or remove a red or amber LED string to a warm or neutral white string to analyze the change in output.

Groups/String: This input helps to define the number of multiple groups present within a LED string. The next section has more details.

Known Lumens: This input enables you to enter a known value (measured or from the data sheet) for Lumens of a given LED string. For example, if the string contains four LEDs from same lumen bin that is rated at 25 lumens, then the total lumens for that string is 100.

Known Dimming: This input enables you to define a dimming value (absolute) for a string based on the Known Lumens for that particular string. For example, assume a 4-LED string gives 100 lumens of light output at a known dimming value of 100 and a max dimming value of 100. If the Known Dimming was entered as 10 with a max dimming of 100, then it means that the string can deliver 100 lumens at one-tenth of the previous dimming value. This setting is useful when modeling load variations.

Max Dimming: This input enables defining the maximum dimming value or, in other words, the dimming resolution. For example a string which uses 10-bit linear or digital dimming has a resolution of 1024 (2^10). In cases where the resolution is not known or the user has only one string, and is using the tool to estimate CRI only, this value can be set to any value greater than the known dimming value.

Relative Setting: Enabling this checkbox allows you to define the lumens output of a string as a value relative to the lumens output of another string.

Relative String: This input is valid only when the Relative Setting checkbox for the string is enabled. This input allows you to define dependency of one string on another. This is achieved by entering the number of the string to which this particular string is to be made relative.

Relative %: This input is valid only when Relative Setting checkbox for the string is enabled. It allows you to enter the relative value in terms of % lumens output of the string to which this particular string is to be made relative.

Fixed Dimming: This input is valid only when the Relative Setting input is disabled. Enabling this input allows the user to override dimming values computed by the tool to a specified value. For example, this parameter can be used to study the effects of elevated temperatures on CRI by selecting a dimming value based on the light output versus temperature curve from the LED data sheet.

Fixed Dimming Value: This input is valid only when the fixed dimming checkbox is enabled. It is used to specify a fixed dimming value for the corresponding LED string. The maximum value is limited by the Max Dimming chosen for the string.
CQC- LED Group Inputs Section

This section allows the user to define properties of a LED group. Version 1.0 of the tool supports up to a maximum of 30 groups (which may be distributed among 8 LED strings). Each string can have one or more groups. Similar to strings, group properties can be defined as absolute or relative values. Even a luminaire which contains only one LED has one string with one group.

Figure 19. Snapshot from CQC - LED Group Inputs

<table>
<thead>
<tr>
<th>LED Group Inputs</th>
<th>Groups 1-10</th>
<th>Groups 11-20</th>
<th>Groups 21-30</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED Groups</td>
<td>1 2 3 4 5 6 7 8 9 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group Enable</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LED String</td>
<td>1 2 3 4 5 6 7 8 9 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group Type</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Part #</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Bin</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lumen Bin</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ref. Luminous</td>
<td>100 100 100 100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dominant λ</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Peak λ</td>
<td>400 400 400 400</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FWHM</td>
<td>1 1 1 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SPD Start λ</td>
<td>750 750 750 750</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SPD Step λ</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SPD End λ</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SPD Loaded</td>
<td>Yes Yes Yes Yes Load Load Load Load Load</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Group Radio Buttons (Groups 1-10, Groups 11-20, and Groups 21-30): These inputs allow you to view and define properties for multiple groups when greater than 10 groups must be defined. Only 10 groups are displayed at a time for easy viewing.

Group Enable: This input is similar to the string enable input as it allows you to enable/disable a LED group. This feature can be used to study how the CRI and other output parameters are affected by disabling one or more groups.

LED String: This input associates a particular LED group to a string. This is done by placing the LED string number in this field. Recalling the Groups/String parameter allows you to define the number of groups for a LED string. However the actual mapping of group to string is done using the LED String input. For example, if LED string #1 has three groups associated with it, then three of the defined groups have the LED String parameter set to ‘1’. Figure 20 shows an example of four LED strings, each consisting of one group.

Figure 20. Snapshot from CQC - LED Group Inputs

Group Type: This input defines the way in which LED spectral properties are entered. The available choices are: Spectral Power Distribution (SPD Start λ, SPD Step λ, SPD End λ, and SPD Loaded). Spectral power data is usually given in a LED data sheet in the form of SPD curves usually plotted with a 50 nm wavelength resolution. Higher resolution improves the accuracy for CRI and CCT calculations as SPD defines the color of an LED. Most LED manufacturers may share SPD data with high resolution in Excel or CSV format. Note that currently in the CQC, SPD is the only input methodology supported for white LEDs of any CCT.

All the parameters discussed in this section are valid or enabled only when the ‘SPD’ option is selected for the group type. As stated earlier, if you have SPD of a light source, make sure that SPD is in CSV format with the first column containing wavelengths and the second containing the spectral power in arbitrary units (see Example CQC Test Case on page 11). The CSV file has to be in this format for it to be recognized by the CQC. For the tool to be able to read a SPD CSV file and process it accurately, the following inputs are required.

- SPD Start λ: This parameter allows you to input the start value from which the wavelength input has to be read in the CSV file.
- SPD Step λ: This input allows you to enter the steps in which the SPD values should be read from the CSV file (in other words, the resolution of input file).
- SPD End λ: This parameter allows you to input the end value until which the wavelength input has to be read from the CSV file.

SPD Loaded: The “Load” displayed in this text box is a hyperlink. When you click on this, a pop-up window opens. This allows you to point to the location of the SPD file which can be anywhere in the user’s PC. However, it is recommended to place all files in a single directory (../files). This makes it easier to save and reopen the UI as a *.CQC file and also makes it easier to distribute/archive designs (see the section Saving the UI and Distributing Test Cases on page 11).

Dominant Wavelength (Dominant λ): Most narrow bandwidth LED data sheets (except Royal Blue) provide this value. Dominant wavelength is defined as the single wavelength perceived by the human eye that has the same apparent color as the light source. This specification methodology is not supported in Version 1.0 of the tool.

Peak Wavelength (Peak λ): This wavelength represents emission from a light source as perceived by photo detectors rather than the human eye. The peak wavelength is defined as that single wavelength where the radiometric emission spectrum of the light source reaches its maximum value. This value can also be found in a few LED data sheets. Usually, this is the only wavelength specified for royal blue LEDs.
Bin Code (Part #, Color Bin, Lumen Bin): This feature is intended as a click and go selection of LEDs from a built-in LED catalogue spanning across manufacturers. It is similar to the Bin Selection feature in the 3-LED Color Mixing system-level example project available in the design catalogue of PSoC Designer. This feature is not supported in Version 1.0 of the tool.

Rel. Lumens: This input allows you to define the lumens for a group as relative value. This is valid only when more than one group is present.

Dominant $\lambda$: This is selectable only when “Dom” is selected under group type. This input allows you to enter the dominant wavelength for the LED from the data sheet.

Peak $\lambda$: This is selectable only when “Peak” is selected under group type. This input allows you to enter the peak wavelength for the LED from the data sheet.

FWHM: The Full Width at Half Maximum (FWHM) input allows you to specify the half maximum width of the spectral curve for a monochromatic LED from the data sheet.

Figure 21 [8] Definition of Full With at Half Maximum

This parameter along with dominant or peak wavelength can be used to reconstruct the spectrum for a monochromatic LED source. The FWHM input is selectable only when “Dom” or “Peak” is selected under group type.

CQC- Input SPDs Window

An alternate way to view SPD properties is by using the SPD spectral graph option from the “View” tab. This option allows you to view SPD plots graphically.

Figure 22. Input SPD window in CQC

Input SPDs specified in the form of a CSV file and Output SPDs generated by the tool can be viewed by selecting ‘Tab’ on the top left corner of the window (see Figure 22).

The input SPD viewing options are as follows:

- SPD Group: This parameter allows you to specify the particular group for which the SPD information must be displayed.
- Read: Clicking on this button loads the SPD for the LED group specified in the SPD Group box. A pop-up browser opens and as soon as a CSV file is selected, the SPD is displayed graphically on the chart.
- View: By clicking on this button, you can graphically view a SPD that was loaded earlier. It displays the SPD corresponding to the group number entered in the SPD Group box.
- Clear: Clicking on this button clears the chart area.

The next section discusses the Output SPD tab along with all the outputs.

CQC- Outputs

Finally, immediately after valid inputs are entered and the Calculate button (which is part of the “Target Color Inputs” section) is pressed, a pop-up indicating successful operation opens up. After the “OK” button on the pop-up output is clicked, text boxes are refreshed.

Figure 23. Snapshot from CQC – Target Color Inputs

Apart from general CRI (Ra), the outputs provide dimming settings for each LED string, the Max lumens that can be expected from the Luminaire (without considering Thermal effects), and the delta uv error between the test lamp’s CCT and the reference CCT as computed by the tool.

Figure 24. Snapshot from CQC-Outputs
Degrees of Freedom (DOF): This output indicates the total number of non-relative strings defined for the luminaire modeled. There are three possible DOFs supported in Version 1.0 of the tool:

- **Zero DOF** - A luminaire modeled with zero DOF can use the CQC to calculate chromaticity coordinates and CRI.
- **One DOF** - A luminaire modeled with one DOF can use the CQC to calculate dimming values for a target lumens, chromaticity coordinates, and CRI.
- **Three DOF** - A luminaire modeled with three DOFs can use the CQC to calculate dimming values for a target lumens, chromaticity coordinates, and CRI.

**Note**: Two DOFs and greater than three DOFs are currently not supported in Version 1.0 of the tool. However, luminaires with such attributes can be modeled using an alternate method in which LED string lumens can be made relative to the lumens of another LED string or fixed LED strings can be used instead of relative strings.

**LED Strings**: Displays the LED string numbers.

**Dimming Setting**: The values here indicate computed dimming settings for enabled LED strings. These values can be directly used with Cypress’s EZ-Color or PowerPSoC family of devices to specify either the “Signal Density” parameter for PrISM or the “Duty Cycle” parameter for the PWM hardware blocks assuming the values are within the regulator’s dimming limits.

**Note**: Version 1.0 of the CQC assumes that inputs used to model LEDs in the luminaire are at the temperature specified in LED data sheet. Therefore, the CRI output may vary depending on the final system temperature. However Cypress’s intelligent controllers can compensate for change in temperature by adjusting dimming values through techniques developed for the EZ-Color platform.

**Lumens**: Indicates the specified input lumens for the luminaire.

**CRI R1-R8**: This output indicates the special CRI computed for each of the eight pastel color samples defined by CIE.

**Ra**: Indicates the general CRI computed, which is an average of R1 through R8. With the maximum value being 100, Ra gives a scale that matches well with the visual impression of color rendering.

**CRI R9-R14**: This output indicates the special CRI computed for each of the six saturated color samples defined by CIE.

**R15**: This output indicates the special CRI computed that corresponds to color rendering for Japanese skin complexion.

**\( \Delta \text{uv} \) or \( \Delta u'v' \) or \( \Delta xy \)**: This output indicates the direction of error for the selected color space.

**Input CCT**: This output indicates the CCT of the test lamp or luminaire whose chromaticity is entered using one of the four options provided in the “Chromaticity Coordinates” input section.

**Max Lumens**: This output indicates the computed maximum lumens obtainable from a luminaire with the specified string inputs.

**Chromaticity coordinates \((u,v) \) or \(u'v' \) or \(xy \)**: These outputs indicate chromaticity values computed for the test lamp corresponding to the chosen color space.

### CQC- Output SPDs Window

An alternate way to view SPD properties is by using the SPD spectral graph option from the “View” tab. This option allows the user to view SPD plots diagrammatically. The Output SPDs window is shown in Figure 25.

**Figure 25. Output SPD graph in CQC**

**View**: To view a LED group’s output SPD, select G from the first pull down menu under SPD Group/string category, enter the group number in the text box and click the View button. The selected Group SPD is displayed in the chart and also added to the Visible Groups list. Similarly a LED string’s SPD can also be viewed by selecting S from the first pull down menu and following the same procedure.

**Write**: You have an option to export the output SPD to a CSV file. To do that, select G or S for group or string from the first pull down menu under the SPD Group/string category, enter the group or string number in the text box, and then click the Write button. A pop up window opens where you can select the location for the create file.

**Clear**: This option allows you to clear a selected group or string SPD when multiple SPDs are visible in the chart. To do this, select G or S from the first pull down menu under the SPD Group/string category, enter the group or string number in the text box, and then click the Clear button.

**Clear All**: As the name indicates, clicking on this button clears the chart.
O/P SPD: This option enables you to view the output SPD.

Note By default the output SPDs are displayed when the user clicks the Calculate button. However if the output SPD window is cleared, then the same can be revoked for viewing in the chart by clicking this button.

Ref SPD: This option enables you to view the reference SPD.

Note Similar to the O/P SPD option, the reference SPD is displayed when the user clicks the Calculate button. However, if the reference SPD is cleared, then the same can be revoked for viewing by clicking this button.

CQC- Output CIE Diagram
You have an option to view the output chromaticity coordinates in one of three standard color spaces selected (CIE1931/1960/1976). In Version 1.0 of the tool, this window displays the test lamp's output chromaticity coordinates computed by the tool, and the input string chromaticity coordinates you specified. Move the mouse over the color points in the chart to view the chromaticity coordinates.

Figure 26. CIE 1931 Chart with Input and Output Coordinates Plotted in CQC

The input CCT is also plotted on a mired scale to give an idea of the visual appearance of the lamp (warm or neutral or cool).

Saving the UI and Distributing Test Cases
It is possible to save the entire UI in a XML file format with an extension of *.CQC by using the File > Save option. To reopen a saved *.CQC file, use the File > Open option. However, the Save option does not save the CSV files that are used for SPD Group inputs. Therefore, ensure that the CSV files with the same name and stored location are distributed along with the CQC file (see Example CQC Test Case).

Example CQC Test Case
An example test case is distributed with the tool. It demonstrates the RGB+A combination used to get a tunable white light with high CRI. Unzip the example.zip file contents. Open the CQC tool installed on your computer and use the File > Open option to locate and load the example.cqc file. Note that the SPD for white LED is also loaded.

Summary
This application note discusses the concepts of tunable white light, color rendition, and need for color quality metrics. The definitions of CRI and CCT are also explained. The procedure for using Cypress’s Color Quality Calculator to compute dimming values for each string with an estimated CRI value is described. This application note and the CQC tool will enable lighting designers to make accurate estimates in a very cost and time effective manner early in the design process.

Note Color Quality Calculator Ver.1.0 is now available. For details on obtaining this, contact Cypress Sales.
References

1. “When white light isn’t white” by MIKE WOOD
3. “CIE Fundamentals for Color Measurements”, Yoshi Ohno, Optical Technology Division, National Institute of Standards and Technology, Gaithersburg, MD 20899 USA
4. “Equivalent White Light Sources and CIE Illuminants”, www.hunterlab.com

About the Authors

Name: Prasanna Vijayakumar
Title: Applications Engineer Staff.
Background: Prasanna has an undergraduate degree in Electronics and Instrumentation from Birla Institute of Technology and Science, Pilani, India. He works on customer support for power converters designed for high brightness LED applications using Cypress Lighting Solutions.
Contact: Email: pvv@cypress.com
Ph: +91 44 66775526

Name: Kaushal Vora
Title: Applications Engineer Sr.
Background: Kaushal has a graduate degree in Electrical Engineering from the University of Southern California. He currently works in the PowerPSoC® group, where he is responsible for aiding customer designs, designing collateral, and product definitions.
Contact: Email: kaushal.vora@cypress.com
Ph: (408)-544-1691
### Document History Page

**Document Title:** CCT and CRI in LED Lighting – AN58765  
**Document Number:** 001-58765

<table>
<thead>
<tr>
<th>Revision</th>
<th>ECN</th>
<th>Submission Date</th>
<th>Orig. of Change</th>
<th>Description of Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>**</td>
<td>2856078</td>
<td>01/25/2010</td>
<td>PVV</td>
<td>New Application Note</td>
</tr>
<tr>
<td>*A</td>
<td>3874237</td>
<td>01/18/2013</td>
<td>MKKU</td>
<td>Obsolete document.</td>
</tr>
</tbody>
</table>

PSoC and PowerPSoC are a registered trademarks of Cypress Semiconductor Corp. "Programmable System-on-Chip", EZ-Color, and PSoC Designer are trademarks of Cypress Semiconductor Corp. All other trademarks or registered trademarks referenced herein are the property of their respective owners.

---

© Cypress Semiconductor Corporation, 2010-2013. The information contained herein is subject to change without notice. Cypress Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted nor intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all charges.

This Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by and subject to worldwide patent protection (United States and foreign), United States copyright laws and international treaty provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of creating custom software and or firmware in support of licensee product to be used only in conjunction with a Cypress integrated circuit as specified in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this Source Code except as specified above is prohibited without the express written permission of Cypress.

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials described herein. Cypress does not assume any liability arising out of the application or use of any product or circuit described herein. Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress' product in a life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all charges.

Use may be limited by and subject to the applicable Cypress software license agreement.